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Introduction
#1 for over 25 years, Act! is the trusted choice for individuals, small businesses, and sales teams to get
organized and take the guesswork out of marketing to drive sales results.

Who Should Use This Guide?
You should use this guide if you have one of the following versions of Act! installed:
l

ACT!, ACT! Premium for Workgroups, or ACT! Premium for Web 2005 (7.x.)

l

ACT! by Sage, ACT! by Sage Premium for Workgroups, or ACT! by Sage Premium for Web 2006 (8.x)

l

ACT! by Sage, ACT! by Sage Premium, or ACT! by Sage Premium for Web 2007 (9.x), 2008 (10.x), 2009
(11.x), or 2010

l

Sage ACT! Pro, Sage ACT! Premium, or Sage ACT! Premium (access via web) 2011, 2012, or 2013

To determine the version of the product you are using, check the version number (from the Help menu, select
About). After the upgrade has been installed, the version number will read “16.x.x.x".
If you do not have one of the previous versions installed, then DO NOT USE this guide. Instead, see the
appropriate guide:
If your current version is...

Then use this guide...

I do not have any version of Act!
installed. I am a "New User."

Use the Installing Act! for New Users guide to install, register, and activate Act!.

I have an ACT! 3.x, 4.x, 5.x (2000), or 6.x
(2004) version installed.

Use the Upgrading to Act! v16 from ACT! versions 3.x, 4.x, 5.x (2000), or 6.x
(2004) guide to upgrade and convert your database.

The guides are available on the installation panel under Product Documentation. Adobe® Reader® is
required to access and view product documentation from the installation panel.

About This Guide
This guide explains how to upgrade Act!.
Act! Premium includes access via Windows® (desktop) and web. If you are installing access for users via the
web, then you will need this guide and the Act! Premium Web Administrator's Guide to complete installation
and configuration. The Web Administrator's Guide is available on the web product's installation panel under
Product Documentation. You can browse the installation files directory for the guide as well. We recommend
that you read the Web Administrator's Guide before installing the web version.
Features exclusive to Act! Premium or Act! Premium (access via web) are noted in the guide. In most
sections, we refer to all versions as Act!.
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Who Can Install This Upgrade?
You can install this upgrade if:
l

l

You are a single user with an Act! database on your computer and that database is Microsoft® Desktop
Edition (MSDE), or Microsoft SQL Server® 2000, 2005, or 2008 Express.
You are one of several users accessing the same database and that database is not on your computer.
Use this document to apply the upgrade to every computer that accesses Act!, including the computer
hosting the database. Make sure all users are upgraded at the same time to prevent issues accessing
the database.

l

You are an ACT! Premium for Web, ACT! by Sage Premium for Web (any version), or Sage ACT!
Premium (access via web) user.
To upgrade your current web product, you need this guide and the Act! Premium Web Administrator's
Guide to complete installation and configuration. The Web Administrator's Guide is available as a PDF
on the installation panel under Product Documentation.

What You Should Know Before Upgrading
Before upgrading, you should understand:
l

Upgrade considerations and recommendations.

l

Database synchronization recommendations.

l

When to downgrade a premium database.

l

Items that do not upgrade.

Be sure to read the entire upgrading document before beginning the upgrade.

Database Upgrade Considerations and Recommendations
The upgrade process involves upgrading an existing database. Review the following considerations and
recommendations before you upgrade.
The database upgrade process overwrites the earlier version database. It is important to have a backup
copy of the database in case you want to re-install the earlier version of the software. Back up the database
before starting the upgrade process.
Who can upgrade a database? An Administrator or Manager user can upgrade a local database. An
Administrator, Manager, or Standard user (if there is no active Administrator user) can upgrade a remote
(Subscriber) synchronized database they belong to. See the section "Database Synchronization
Requirements" for information about whether or not you can upgrade a remote database.
No upgrade required for database supplemental files. Database supplemental files, such as templates,
reports, and layouts, do not need to be upgraded.
Changes for ACT! Premium for Web 2005 and 2006 users Preferences folder. The user Preferences folder
location changed in versions after ACT! Premium for Web 2006. You can restore the preferences by copying
all files to the new Preferences path. See "About User Preferences" in the Act! Premium Web Administrator's
Guide.
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Database Synchronization Recommendations
Customers upgrading from ACT! by Sage 2010 (12.x) or Sage ACT! 2011 (13.x) and later do not need to
recreate their remote databases. You can upgrade a remote database after you install Act!. However,
customers on versions other than ACT! by Sage 2010, Sage ACT! 2011, 2012, or 2013, should follow these
recommendations.
ACT! or ACT! Premium for Workgroups 2005 (7.x), or ACT! by Sage or ACT! by Sage Premium 2006 (8.x)
customers. The database synchronization relationship is lost. We recommend you synchronize remote
databases to one, main (Publisher) database before upgrading. Then, you upgrade the main database and
create new remote databases.
ACT! by Sage or ACT! by Sage Premium 2007 (9.x), 2008 (10.x), or 2009 (11.x) customers. The database
synchronization relationship is retained. However, because of opportunity data changes made in ACT! by
Sage 2010, we recommend that you synchronize remote databases to one, main (Publisher) database before
upgrading. Then, you upgrade the main database and create new remote databases. The new opportunity
data changes will synchronize. For further instructions, see "Upgrade Changes That May Affect Where Your
Data Appears" on page 4.
You can create up to 50 remote databases at one time.

When To Downgrade a Premium Database
If you currently use a Premium version and you plan to install a non-premium version, you must prepare the
database, or downgrade it, to work with the non-premium version before you install Act! Pro. You need the
Premium application to do this. For further instructions, see "Downgrading a Premium Database" on page 9.

Items That Do Not Upgrade
Note the following items that do not upgrade.
Menu/toolbar and column customizations. Customizations are lost. You must redo your menu/toolbar and
column customizations. See the Help for information about menus and toolbars you can customize.
Welcome Page customizations. If an Act! Certified Consultant* customized the Welcome Page in ACT! by
Sage 2010 or ACT! by Sage Premium 2010 for you, these customizations are lost when you upgrade.
Database synchronization Accept Incoming Syncs ON setting. The ON setting for Accept Incoming Syncs is
disabled for customers upgrading from ACT! by Sage 2007 (9.x) and later versions. You must turn database
synchronization ON (Tools > Synchronize Database > Accept Incoming Syncs). The port number is retained.
Act! Synchronization Services (Network and Internet Synchronization Services). You must uninstall earlier
versions of the Sync services, and then install the latest version. To uninstall a Sync service, use Control
Panel>Add/Remove Programs. To install the new versions, see "Installing Other Applications" on page 8.
*Certified Consultants are third-party vendors. Swiftpage ACT! and its affiliates are in no way liable or responsible for claims made related to the
services provided by third-party vendors.
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Upgrade Checklist
The following checklist outlines the tasks needed to upgrade Act!.
Page
#

ü Task
Understand what happens during the upgrade process.

ii

Prepare to install. Important: If your installation includes access via the web, be sure to complete both sets of
steps.

1

Install, register, and activate Act! Premium (access via web).

2

Upgrade the database. Important: Ensure the database remained shared. If not, share it.

4

Install Act! Sync Services. Note: If you used previous versions of Act! Sync Services, you must uninstall them
and install the current version.

8

See the Act! Premium Web Administrator's Guide to configure access via the web.
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Installing Act!
The following sections explain the required components, other considerations, and how to:
l

Prepare to install.

l

Install Act!.

l

Register and activate the software.

l

Upgrade your database.

Several final sections explain upgrade changes that may affect where your data appears and other information
you may need to know.

Required Components
To install and function correctly, Act! requires the following components:
l

Windows® Installer 4.5

l

.NET Framework 4.0

l

Microsoft® SQL Server® 2008 R2 Express

If you do not have a required component, it is installed for you. To help you plan your installation, a page
appears listing the needed components for your operating system, approximate install time, and if a restart
(reboot) is required. You can select to continue the installation or cancel and install later.
NOTE: You can choose not to install SQL Server Express if users will be connecting to a shared Act!
database with SQL Server. However, SQL Server Express must be installed on the computer hosting the
shared database. For Act! Premium (access via web) users, SQL Server Express must be installed on the
database server or web server, depending on your configuration. See the Act! Premium Web Administrator's
Guide.

Other Considerations
Other add-on products. Some applications added as plug-ins or add-on products in earlier versions may not
upgrade. These applications may require re-installation after installing the software. Visit Act! Marketplace or
contact your add-on product provider to determine compatibility.
Microsoft Outlook®, Word, and Excel® integration. Act! integrates with Microsoft Outlook, Word, and Excel.
(For compatible versions, see System Requirements at www.act.com/systreq.) If you plan to use the integration
features, ensure the Microsoft software is installed and working correctly before installing Act!. You must set up
an Outlook profile. To configure and set up integration for Act! Pro or Act! Premium users after installation, see
"About Microsoft Outlook Integration" in Help. To configure and set up integration for Act! Premium (access via
web) users, see the Act! Premium Web Administrator's Guide.

Preparing to Install
Before installation, complete these steps in the order presented. Customers on ACT! Premium for Web (all
versions) or those planning to install Act! Premium (access via web), must also complete the second set of
preparation steps.
Prepare to install (all versions)
1. Ensure your computer (or all computers in a shared environment) meet the minimum recommended
system requirements for your purchased product and operating system. Also, verify you meet the
concurrent user limits and licenses. See system requirements at: www.act.com/systreq.
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2. Ensure you are current with Microsoft critical and recommended updates.
3. Restart all computers to free available resources before you install.
4. Sign on to all computers as a Microsoft Windows Administrator. If you do not, installation may fail.
5. (Recommended) Disable any software-based firewalls. You can enable these after installation.
6. Act! integrates with versions of Microsoft Outlook, Word and Excel. For compatible versions, see
www.act.com/systreq. Ensure the Microsoft software is installed and working correctly before installing
Act!. You must have an Outlook profile configured for Outlook integration setup.
7. Customers on ACT! or ACT! Premium for Workgroups 2005 (7.x) through ACT! by Sage or ACT!
by Sage Premium 2009 (11.x) only: Synchronize remote databases to one, main database. After you
install and upgrade the database, you can create new remote databases.
8. Customers on any ACT! Premium version who are planning to upgrade to Act! Pro, a nonpremium version: You must downgrade the premium database before installing Act! Pro. The
premium database will not open in the non-premium version. For steps to downgrade, see
"Downgrading a Premium Database" on page 9.
9. Open your current Act! version and perform database maintenance. On the Tools menu, click
Database Maintenance.
Prepare to install Act! Premium (access via web) or upgrade to Act! Premium (access via web) from
earlier versions of ACT! Premium for Web
1. Act! Premium requires that Microsoft Internet Information Services (IIS) 6 and ASP.NET run in 32-bit
compatibility mode. If you use 64-bit versions of these applications and do not want the installer to
switch them to 32-bit mode, see the solution under "General Errors and Issues" in the
"Troubleshooting Act! Premium (access via web)" section of the Act! Premium Web Administrator's
Guide. IIS 7 allows both 32-bit and 64-bit processes to run simultaneously.
2. See Microsoft documentation to help you plan your installation and prepare your web server. You
need to understand your operating system, IIS, ASP.NET, and user permissions required to run a
web page.
3. Install, or enable, the correct version of IIS for your operating system. Verify it runs properly. Some
supported operating systems automatically install IIS, however, you may have to enable it.
4. Install ASP.NET or verify that ASP.NET impersonation authentication is enabled.
5. If you are using a firewall, enable an exception for World Wide Web services.
6. Give your web server a static IP address and make a note of it. You will need it later when you
configure access.
7. Gather the virtual directory or virtual server names of other web sites hosted on your web server.
8. If you use Windows Vista® as a web server to host Act! Premium (access via web), change the
"sleep mode" setting to Never.
9. Customers on earlier versions of Act! Premium (access via web):
a. Have web users log off the Act! database.
b. Open Act! and use the Web Administration tool to remove the database from the web site. Once
the database upgrade is complete, you can add the database back to the web site and reset IIS.
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Installing Act!
IMPORTANT: If you are installing Act! Premium (access via web) in a multiple-server configuration, install the
application on the database server (even though you will be running it from the web server). Installing on the
database server creates the Microsoft SQL Server instance for Act!. You connect to the database from the web
server. For upgrading customers, install Act! Premium (access via web) on the server with the earlier version.
Install Act! (all versions)
1. Close all open applications.
2. Do one of the following:
l

Complete the download process from the Act! web site.

l

Double-click the setup.exe file if you are installing from a network location.

l

Insert the installation DVD. The installation program should automatically start, but if it does not,
click Start, and select Run. Type <drive letter>:SETUP.

The installation panel appears with links to install Act!, install Synchronization Services (Act! Premium
only), and access product documentation and online resources.
NOTE: In the installation process, if a message appears about Microsoft .Net Framework 4 Client
Profile, you can click OK to continue. No action is necessary.
2. On the main installation screen, click Install Act!.
3. On the Installation Requirements page, review the information. Click Install to continue.
4. If prompted, agree to install the required components. A restart may be necessary after installation.
NOTE: If the installation does not automatically start after a required restart, click Setup.exe to
continue.
5. On the Regional Version page, select the version to install. Click Next.
6. At the "...Earlier version detected and needs to be uninstalled" message, click Yes to continue.
7. On the License Agreement page, read the agreement, and then click Accept. (If you Decline,
installation is canceled.)
8. On the Type of Install page, Typical installation is selected by default. To change the default install
settings, select Custom. Click Next.
NOTE: With a Custom installation, you can select to install Act! without SQL Server Express. To do
this, clear the Install SQL Server Express check box on the next page. IMPORTANT: If you do not
install SQL Server Express, you cannot create or restore a database. However, you can connect to a
shared database. Other custom options let you choose where to install Act! and SQL Server Express,
select who can use Act!, specify icons for Quick Launch, and where to place Act! in the Start Menu.
9. When the Install Complete page appears, click Finish.
10. To close the installation panel, click Exit.
To open Act!: Double-click the Act! icon on the desktop. Or, on the Start menu, under Programs, point to the
Act! program folder, and then click Act!. When the software opens, you are prompted to register and activate
it. You can choose to register now or use the software for a trial period of 30 days. For more information
about the trial period, see "About the Trial Period" in Help.

Registering and Activating Act!
You must register and activate Act! within 30 days of first use on each computer where it is installed.
Registration and activation provides you with program updates and customer support options. A serial number
is required to register. The serial number is printed on the DVD sleeve or is emailed to you upon purchase.
You can copy the serial number from the product activation email and paste it into the registration page.
Windows Vista and Windows 7: You must run the software as an Administrator to register it. Close Act!.
Right-click the Act! icon on the desktop or in the Program Files list. Click Run as administrator.
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Register and activate the software
1. On the Help menu, click Register Act!.
2. Select a registration option. Click Next.
3. Follow the on-screen instructions. Click Next to advance.
4. When finished, click Activate. If error messages appear, follow the instructions.

Upgrading a Database
The following explains how to upgrade your database.
Upgrade a database
1. Open Act!.
or
If Act! is already open, when the logon screen appears, enter the user name and password for the
database you want to upgrade. Go to step 4.
2. On the Welcome screen, ensure Open an existing Act! database is selected, and then click OK.
3. In the Open/Share Database dialog box, select the database. Click Open Database.
If you do not see your database in the list, click the "The database I want is not listed" link in the lower
left corner of the dialog box and browse to the location of your database and open it.
You can easily locate, open, and share a database using the Open/Share Database command on the File
menu or the Welcome screen.

4. When prompted to back up the database before upgrading, click Yes.
We recommend that you back up the database so that if you want to reinstall the earlier version of the
software, the database backup copy can be restored in that version. The upgrade process overwrites your
earlier version database, but does not affect the backup copy.

5. Follow the directions on any update and verification prompts that appear.
6. When the update process is complete, click OK.
7. (Optional) If the database was shared with others, click File, then Open/Share Database to ensure it
remained shared. If it did not remain shared, click Share. To open the database, click Open Database.

Upgrade Changes That May Affect Where Your Data Appears
If you are upgrading from a version prior to ACT! by Sage 2010, the following sections provide an overview of
some of the significant changes to the interface in recent releases. For more information about new and
improved features for each previous release, see the Knowledgebase.

Act! v16 Changes
Act! includes features that help you work more efficiently whether you are at your desk, using a tablet, or
traveling with a mobile device.
Mobile companies and groups. You can add, edit, and delete companies and groups on your mobile device.
History List view. The History List view displays all histories for contacts, opportunities, groups, and
companies. You can use this view to filter, export, edit, and print histories.
Calculated fields. You can create a calculated field that uses the values in other fields to display a new value.
Calculated fields can be created as date or numeric fields.
Define fields and layouts on the web. You can create custom fields and assign them to layouts using Act!
Premium (access via web).
Automatic company creation. You can define when to automatically create a company record from contacts
with the same company name.
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Create a lookup from search results. You can use search to find records and create a contact or company
lookup of the results. Once you create the lookup, you can perform actions on the records such as sending
email or running a mail merge.
Updates to Search. Search has been updated to use more intuitive methods to return expected results.
Scheduler email notifications. You can configure the scheduler to send an email notification confirming the
success or failure of a scheduled task.
List and Detail view on a tablet. When using a tablet, you can rotate to landscape view and see a combined
list and detail view. Using this view you can scroll through a list of records in the left pane and view their details
in the right pane.

Sage ACT! 2013 Changes
The following items are new features and improvements designed to simplify how you work with Act!.
New Social Updates Tab. A new Social Updates tab was added to the Contact Detail view. The Social
Updates tab is an internal browser that lets you display web pages specific to social media sites such as
LinkedIn® and Facebook®.*
Offline Smart Tasks. Smart Tasks can run independently when Act! is closed or when the user assigned to the
Smart Task is not logged on to Act!.
Smart Tasks Update Field. You can use the Update Field step in a Smart Task template to automatically
update data in one or more fields in contact or opportunity records.
Move Database. New items were added to the File > Move Database menu to simplify the process of moving a
database on the same computer or to another computer.*
Set Up Remote Synchronization. On the Tools menu, the Synchronization Panel item was moved to a
submenu item under Synchronize Database. The Set Up Remote Synchronization item was added which
allows you to create a remote database and enable synchronization without using the Synchronization Panel.*
*These changes apply to the desktop applications only; not to the web client application.

Sage ACT! 2012 Changes
The following items are some of the new features and improvements.
New Search. A universal Search feature was added. To access the new Search, a search text box was added
to the right of the global toolbar and a Search button was added to the navigation bar. The Lookup Search
button was removed from the global toolbar.
New Act! Connected Services view. A new Connections view was added to the navigation bar. You use the
Connections view to sign up for, use, manage, and learn more about services and features integrated with Act!.
New Act! Scratchpad. A new feature called Act! Scratchpad was added to the Tools menu.
New Google® integration. New commands were added to the Contacts, Schedule, and Tools menus to
enable integration with your Google contacts and calendar and Gmail® record history to Act!.
Act! sync service for Outlook sync was renamed to Act! Integration service. The Act! sync service for
Outlook sync was renamed to Act! Integration service because it also enables Google integration. You can
select to integrate your contacts and calendar with Google or Outlook.

Sage ACT! 2011 Changes
Data security, Outlook Contact and Calendar synchronization, and other improvements required changes to
the interface.
New Admin tab added to Preferences. This new Admin* tab was created to combine existing Administratorlevel (and some Manager-level) preferences from other tabs and to display new preferences. If you cannot see
the Admin tab, use the arrow buttons to scroll through the tabs.
Notes and History preferences moved from General tab to Admin tab. The check boxes for the “Allow
history editing” and the “Allow notes editing” options were moved from the General Tab (under General
Preferences) to the new Admin tab. Your current settings are retained.*
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Names Preferences moved from General tab to Admin tab. On the General Tab, replaced the “Names”
group with a “Salutation” group and moved access to the ”Name Preferences” option to the new Admin tab.
Your current settings are retained.*
Companies Preferences moved from Startup tab to Admin tab. Moved access to the “Company
Preferences” options from the Startup tab to the new Admin tab. Your current settings are retained.*
Duplicate Checking Preferences moved from General tab to Admin tab. Moved the “Disable or enable
duplicate checking” option from the General tab to the new Admin tab. Your current settings are retained.*
Outlook Copy Calendar preferences converted to Outlook Synchronization preferences. Copy Calendar is
now full calendar synchronization. The Copy Calendar setup was moved from the Calendar & Scheduling tab
to the renamed E-mail and Outlook Sync tab under Preferences. Your copy calendar preferences are retained
as calendar synchronization preferences.
Renamed E-mail tab to E-mail and Outlook Sync tab. This tab was renamed to include Outlook
synchronization options and to better display e-mail setup options.
Welcome Page redesign. The Welcome Page introduced in ACT! by Sage 2010 was redesigned to provide
better usability.*
Change to Act! Scheduler for Manager users regarding attachments to backups. Data security changes for
attachments included a new security setting that allows only Administrator users to back up attachments with
the database. If you have a Manager user with scheduled database backup tasks in the Act! Scheduler, those
backup tasks will upgrade; however, no attachments will be backed up. You must delete any database backup
tasks with attachments scheduled for a Manager and set them up again for an Administrator.
New categories to filter by history types on the History tab. New categories of histories by type (such as emails and correspondence, completed activities, system changes, or attached files), were added to the History
tab. These new categories let you drill down to see the histories.
*These changes apply to the desktop applications only; not to the web client application.

ACT! by Sage 2010 Changes
Opportunities were redesigned to work in the same way as Contacts, Groups, and Companies. Other new
features may affect where and how you access your existing data.
New Opportunity Detail view. A new Opportunity Detail view layout was added. The layout has the same
default tabs as the contact, group, and company layouts. After upgrading your database, some of the changes
include:
l

Groups and Companies associated with an opportunity appear on the Groups/Companies tab.

l

Details for an opportunity become notes and appear on the Notes tab.

l

Follow-up activities scheduled for an opportunity appear on the Activities tab.

l

History information, such as the date the opportunity was opened, appears on the History tab.

l

Opportunity record access, such as public or private, appears on the Opportunity Access tab.

New Welcome Page. A new Welcome Page is the default view that opens when you open a database. This
page has links to Help topics, feature tours, and more. You change the default view to open in Preferences.
New Navbar, global toolbar, and view toolbars. The navigation bar was redesigned to include more views,
such as Reports and Opportunities. A Related Tasks area was included in the Navbar for easy access to tasks.
A global toolbar with large buttons makes it quicker for you to get to the tools you need. Each view has its own
view toolbar.
New Web Info tab for Contacts and Companies. The Web Info tab is an internal browser that lets you display
web pages specific to a contact or company.
Internet Services and Favorite links moved. Internet Services links appear on the new Web Info tab for
Contacts and Companies. Favorite links are accessed from the View menu.

Act! Connections View
Act! offers subscription-based services, most with trial periods or free levels, and links to integrated
applications. To see all services and integrated apps, on the left navigation bar, click Connections.
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Next Step(s)
Single Users:
l

Read the Quick Start for New Users guide or watch Featured Videos accessed from the Welcome Page.

Act! Premium (access via web) Users:
1. Assign the upgraded database to the web site and reset IIS.
2. Verify access for your web users and complete other configuration tasks. See the Act! Premium Web
Administrator's Guide.
Workgroup Users:
1. Read the Quick Start for New Users guide or watch Featured Videos accessed from the Welcome Page.
2. If you use a shared database, ensure all users install the same Act! version. Then, you can distribute a
shortcut to the .PAD file for the database. (The .PAD file is pointer to the database. Users open a
database from the .PAD file.)
3. Create new remote databases for database synchronization (not required for previous ACT! by Sage
2010 or later users). For more information, see "About Database Synchronization" in Help.
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Installing Other Applications
The section explains how to install Act! Synchronization Services (available for Act! Premium only).

Act! Synchronization Services
Act! Premium offers two data synchronization services. These services let remote workgroup users, with their
own Act! Premium database, synchronize their data to the main workgroup database without Act! being
opened and active. You can install one or both services depending on your needs. For more information about
database synchronization, see Help.
Act! Network Synchronization Service. Lets you synchronize Act! Premium databases over a network. This
service can be used by remote users connected to the main database via a Local Area Network (LAN), Wide
Area Network (WAN), or a Virtual Private Network (VPN). You can install the service on the same computer as
Act! or on another computer.
Act! Internet Synchronization Service. Lets you synchronize Act! Premium databases over the Internet. This
service requires a computer (located outside the firewall) with ASP.NET and Microsoft Internet Information
Services (IIS) installed (compatible with your operating system). See system requirements at:
www.act.com/systreq.
NOTE: Act! Pro users can synchronize data between a main and remote database, but do not use the
synchronization services. For Act! Pro database synchronization, the Act! application must be open on the
computer hosting it. For more information, see "About Database Synchronization" in Help.

Installing Act! Synchronization Services
The following explains how to install an Act! Synchronization service. You install one service at a time. After
installation, you must configure it.
IMPORTANT: If you install the Act! Internet Synchronization Service on a computer that does not have Act!
Premium installed, ensure the <computer name>\ASPNET account has read/write permissions on the Internet
Sync install folder. For more information, see Help.
Install a Synchronization Service
1. Open the installation panel, double-click the setup.exe file, or insert the installation DVD.
2. On the installation panel, click Install Act! Synchronization Services.
3. Click the link to install a synchronization service.
If the required version of .NET Framework is not detected, it will be installed with the synchronization
service components.
4. Follow the on-screen instructions. Click Next to advance. Click Finish.

Next Step(s)
1. Set up Synchronization Services. See one of the following topics in Help:
l

Setting Up and Managing the Internet Sync Service.

l

Setting Up and Managing the Network Sync Service.

2. Get started using Act!.
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Downgrading a Premium Database
Downgrading a premium database removes several premium features and allows the database to be used
with a non-premium version of the software. After downgrading the database, do not reopen the database until
you have installed the non-premium product. Be aware of the following considerations if you are planning to
downgrade a premium database.
Who can downgrade a database? Only Administrator or Manager users can downgrade a premium database.
When should you downgrade a database? You must downgrade the database before you uninstall the
premium application.
What happens to database fields with access level of No Access? Fields with an access level of No Access
convert to Read Only access. No Access field-level security is not available in a non-premium database.
What happens to database synchronization when I downgrade my premium database? The database
synchronization relationship between main (Publisher) and remote (Subscriber) databases is lost. Therefore,
you should synchronize all remote databases to the main database before uninstalling the premium version.
You then downgrade the premium, main database. Once you open the main database in Act! Pro (nonpremium version), you can create up to 50 new remote databases.
Downgrade a premium database to a non-premium database
1. (Optional) Synchronize all remote databases with the main premium database.
2. In the premium application, on the File menu, click Save Copy As.
3. In the Database Name field, type the name of the new database.
4. In the Database Location field, type the location for the database, or click Browse to locate a folder to
save the new database to.
5. ACT! by Sage 2010 or Sage ACT! 2011 users only: Select a currency for the database.
6. To share the database with other users, select the Share this database with other users check box.
7. IMPORTANT: In the Database Version list, select Act! Pro. Be sure to select the item that does not
have Premium in the title. You need the database to be a non-premium version.
8. Click OK.
9. A prompt appears about default permissions of fields changing from No Access to Read Only. Click
OK.
10. The saving status message appears until the process is complete. Click OK.

Next Step(s)
1. Install Act! Pro and open the database.
2. Create new remote databases for database synchronization. See "Creating Multiple Remote
Databases" in Help.
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